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Minutes Styles & Recording
Information

Learning Outcomes
By the end of this unit the learner will be able to:

v' Be able to remedy many of the complaints that beset Minute-Takers both through best

practices and through use of the OneNote software.
v Be able to write minutes that are suitable for formal meetings, semi-formal meetings, and
action minutes using the templates provided in the example Minute-Taker notebook (or their

own customized templates).
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Unit 2

Minutes Styles & Recording Information

Choosing a Style

Minutes are a permanent, formal record of what went on in a meeting. Their purpose is to
provide members of a group with:

A clear, objective summary of the group’s activities.

A means of conveying information to people unable to attend the meeting.

A reminder of future expected actions.

A historical background of the decisions of the group and the rationale behind them.

When approved, minutes are considered legal documents and can be used in legal proceedings.

Minutes may be written in a variety of styles, including formal, informal, or action. The choice
of style is based on the nature of the meetings and the bylaws of the members themselves.

Formal minutes support a meeting which is governed by a chair according to a parliamentary
code or procedure. There are a number of reference guides to parliamentary procedure, such
as Robert’s Rules of Order or Procedures for Meetings and Organizations.

Semiformal or action minutes are used by small groups who do not have a clearly defined
operating structure.

Minutes don’t have to be verbatim to be proper, with the exception of motions, which should
be recorded word for word. Word for word documents are too time-consuming to prepare and
to read. However, groups differ as to how much detail they require. Some groups want minutes
to be an outline of everything that was discussed so they have justification for decisions. Others
feel that background information is not essential, providing members understand the remarks.
It is important that you, as Minute-Taker, know what type of minutes the group expects to
receive and can deliver them consistently.

For example, a committee concerned with public hearings relating to changes in municipal
bylaws can correctly choose one of two styles:
Comprehensive minutes with a detailed rationale for every decision.
Minutes that are concise, with the rationale “passed in accordance with Section 345 of
the Zoning Bylaw.”
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Informal Minutes

Small groups, perhaps because of their size, sometimes prefer to operate more informally.
However, minutes are still a vital component of the meetings and can be prepared as described.
Informal minutes support meetings that operate on a modified version of parliamentary
procedure. They report what occurred at the meeting for the people who were absent, and for
future reference. They summarize the action taken, the action planned, the people responsible,
and the deadlines.

Informal minutes are written in a narrative format in complete sentences. They include some
background information, keeping in mind they are written solely for the benefit of people
already familiar with the group and its activities.

Action Minutes

Action minutes are best suited for meetings that operate in a purely conversational manner.
They can be written in point form. You need to identify the person or people responsible for
future actions and set time limits.

In many informal meetings the Minute-Taker is encouraged to participate in discussions, or the
chair may also act as Minute-Taker. In some groups, members share the responsibility of
Minute-Taker with a different person appointed for this task at each meeting. In such
situations, action minutes are usually easiest to use. They allow you to make notes as well as
participate, and the straightforward format keeps the minutes consistent despite the different
people involved.

Formal Minutes

In formal meetings, decisions are reached through motions. Motions are proposals placed
before the members for debate and voting. These must be recorded verbatim.

When you are organizing the minutes of a formal meeting, they follow the same organizational
pattern as the steps in a formal meeting.
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Heading

The heading should be one inch from the top of the page. Each heading line should be centered
and typed in the style preferred by the organization (either capitals or uppercase/lowercase
letters).

The heading should include the word “Minutes” and the name of the group or committee
holding the meeting.

Introductory Paragraph

There is no rule about which line should come first, but be consistent. Use the same style for all
of an organization’s minutes and agendas. The place, time and date of the meeting can be in
the heading or in the introductory paragraph. (If the place of the meeting is always the same, it
may be omitted.)

The minutes should also state whether the meeting is a regular (weekly, monthly, yearly) or
special meeting.

Attendance

Include the names of those who attended as well as the names of those invited who did not
attend. These can be listed casually or in alphabetical order. List people who are not regular
members as “In Attendance.” You should also record who chaired the meeting, as well as your
name as the recording secretary/note taker.

Minutes of Previous Meeting

At the beginning of the meeting, the chair asks the members to approve or amend the minutes
of the last meeting. You can record this decision as a motion. However, it is preferable to use
one of the following standard forms:

Minutes of the June 10, 2020 meeting were approved as read.

Minutes of the June 10, 2020 meeting were approved as circulated.

Minutes of the June 10, 2020 meeting were approved with corrections.

The reading of the minutes of the June 10, 2020 meeting was deferred until...

Reports

This includes any reports received from any of the groups’ officers or committees. As Minute-
Taker, you must summarize any reports or other documents presented at the meeting and then
either attach them to the minutes as an appendix or refer to them in the minutes as “filed.”

If a report was sent to the group for information purposes only, indicate the report was
“received.”

If a report was presented orally, or accompanied the report with a verbal explanation, indicate
the report was “presented.”
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If the report contains a statement of opinion and facts, and concludes with resolutions, then
you should record the report was “adopted” or “accepted.” A report could also be “considered”
if the group wants to look at it further.

When the group decides to “adopt” a committee’s resolutions, enter the resolution in full into
the minutes. With a particularly important report, the group may order it “to be entered into
the minutes.” In that case you must include the whole report in the minutes.

After someone moves either to accept or to adopt a report, the report is then open to
amendment by the group.

Finances

Finances are usually discussed under the treasurer’s report. No action is required for this type
of report. In fact, it is technically improper to approve the treasurer’s report unless it has been
audited. A treasurer’s annual report is different. It will be in written form and should be
audited. Then a motion and a vote are required on accepting the auditor’s report.

Correspondence

Letters, faxes, and e-mails sent to the group are usually read by the secretary and either filed or
attached to the appendix of the minutes. Telephone conversations may also be handled in this
way.

Unfinished Business or Business Arising from Previous Meeting
This involves motions or issues brought up at earlier meetings and deferred to the current
meeting, details of follow-up, and new actions as a result of previously handled business.

New Business
This portion of the meeting is devoted to the introduction of new information. It may also
include handing specific tasks to specific members of the group and setting deadlines.

Adjournment
The chair may call for a motion to adjourn or may adjourn the meeting himself or herself after
ascertaining there is no further business.

As Minute-Taker, you would record:
The chair adjourned the meeting at 2:30 p.m.
There being no further business, the meeting was adjourned at 2:30 p.m.

Next Meeting
Record the date, time, and location of the next meeting.

Signatures

Highly formal groups still prefer, “Respectfully submitted,” before any signatures, although this
is usually omitted. However, the Minute-Taker’s signature and title should appear at the end of
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the minutes. The Minute-Taker may also choose to include the date when the final preparation
of the minutes was completed. This is optional.

In formal minutes, the chair initials all pages of the minutes and signs the last page to prevent
any alterations.

What Do | Record?

Recording Motions and Resolutions

Motions

In formal style minute-taking, all properly made motions must be included in the minutes.
(Generally, to be proper, a motion must be moved and seconded.) Committee meetings are less
formal and motions made there do not need to be seconded.

It is standard practice that a motion begin with the word, “That,” followed by a noun and a
verb, and that each motion be formed as a positive statement.

The minutes should state who made the motion and whether it was carried, defeated, or tabled
(i.e. postponed). The reason for recording defeated motions is that the issue can only be raised
again under special conditions.

Very formal minutes also include the name of whomever seconded the motion, and if the issue
is contentious, the names of those present and the side they voted on. If the vote is by secret
ballot, the minutes contain the number of votes for each side.

Sample Motions

Here are some simple motions.
MOTION: It was MOVED, SECONDED, AND CARRIED, “That the Board support the
production of an educational brochure on drug and alcohol addiction.”
MOTION: It was MOVED by Jennifer Becevello and SECONDED that the unit hires three
additional salespeople. MOTION DEFEATED.
Dr. Jeff Chin made a motion that Dr. Timothy Luke be granted staff privileges. Dr. Peter
Thomas seconded the motion, which was passed unanimously.
Mrs. Georgina Dodds proposed that the Information Services Branch donate $1,000 to
the Save the Children Campaign. Motion passed by general consent.
Mr. Roy Sconci moved, seconded by Ms. Eileen Hall, that the SK Management Company
takes over the operation of the Rosevale Nursing Home. Motion defeated.
Motion No. 9X-34, moved by Cameron Ward, seconded by Paul Becevello. Moved, that
the Board appoint the YMCA to be the operator of the child care facility opening at
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Queen and Main Streets in September 2020. This operator would also be responsible for
the before school, lunch, and after school programs on the premises. Motion No. 9X-34
Carried.

Here is an example of a series of motions:
It was moved that we hold a picnic.
It was moved in amendment by Ms. Nancy Beeker, seconded by Mrs. Joan Smith: That
we hold a picnic and a dance.
The chair declared the amending motion lost. The question was then put to the main
motion; it was resolved in the affirmative.

Explanation: Someone on the committee moved that the group hold a picnic. Ms. Nancy
Beeker amended the motion in include a dance in addition to the picnic. The chair then asked
the assembly to vote on Ms. Beeker’s amendment. The group voted not to have both a picnic
and a dance. The chair declared the amending motion (Ms. Beeker’s) lost and then called for a
vote on the main motion — to hold just a picnic. The assembly voted yes: they want a picnic.

Here is another example of a series of motions:

It was moved by Ms. Karen Giles that an ad hoc committee for community relations be
established. It was moved in amendment by Mr. Adrian Chin that an ad hoc committee for
community relations, composed of three Canadian citizens, be established. Amending motion
and main motion carried.

Explanation: In this case, Karen Giles moved that an ad hoc committee for community relations
be established. Adrian Chin amended the original motion to include the fact that the committee
be composed of three Canadian citizens and the group voted in favor of this. The chair then had
to ask the group to vote on the main motion — the establishment of the ad hoc committee. The

result of the vote showed that, yes, the group agreed to the committee.

Resolutions

A resolution is a written motion phrased in a special style, with “whereas” followed by resolving
clauses (what the group plans to do about it). You must include in the minutes a full description
of any resolutions that were adopted and a simple statement of any that were rejected.

Resolutions are often lengthy so encourage people to write out their resolution before it is
given to you to record in the minutes.

When typing a resolution follow these guidelines:
Indent all lines 15 spaces.
Type both “WHEREAS” and “BE IT RESOLVED” in capital letters.
Single space between the lines and double space between sections.
Use capital letters and bold type if a person’s name is included.
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Any reference to money should be written out, followed by the numerals in
parentheses. For example, “two hundred dollars (5200).”

Sample Resolution
The Cobden City Council moved the adoption of the following resolution:

WHEREAS, for a number of years MARGARET BOUDREAU has served as president of the
local Cancer Society,

and,
WHEREAS, she has chaired this city’s Literary Guild for two years;
and

WHEREAS, she has been highly involved in the establishment and operation of our food
bank, therefore,

BE IT RESOLVED, that MARGARET BOUDREAU be named “Citizen of the Year,” and,

BE IT RESOLVED, that a donation of two hundred dollars (5200) be made in her name to
the Cancer Society, and,

BE IT FURTHER RESOLVED, that a banquet be held in her honor on Tuesday, the 22nd
day of May, 2020.

What to Record

Whether you use shorthand, longhand, or a computer, remember that only the motions and
resolutions are taken down verbatim. (It is a wise idea to ask the members to put all
complicated motions in writing.) The rest of the minutes are an objective summation of what
actually occurred.

Pay close attention to the discussion. You will find it helpful if you know why a topic is being
discussed. Is the group's purpose simply to obtain information, or is its aim to eventually reach
a decision? If the latter is the case, your notes should be progressive. If the purpose is to solve a
controversial problem, you should have a number of pros and cons recorded. Never inject your
own personal bias or give one person's comments more weight than another's.
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Here are some guidelines.

Record:

All pros and cons

New information

All motions (passed and defeated)
Results of motions

Expected action

AN NI NI NN

Do not record:

Speaker’s experience

Old material

Redundant information
Personal comments

He said/she said information

x

X X %X %

Check with your organization to see if you should record withdrawn motions, as practice can
differ.

Recording Information with OneNote

If you use OneNote in other areas of your job you are probably already familiar with the many
ways you can flow information into it. For those that are not as familiar, we will introduce some
ways in which you can record information in OneNote. Even if all of your students feel
reasonably proficient with OneNote, you should still skim over this section as a refresher.

When creating basic notes during the meeting, you may just want a blank page for you to
brainstorm ideas or create a note without any guidance or instructions. You also might want to

use the area below the provided Minutes templates in the provided notebook.

If you us the provided notebook when you add a new page in a Meeting Minutes section, the
new page will use the template for that section (Meeting Minutes).

If you are not using a Meeting Minutes section, a blank page will be created unless you have
designated a default template for that section (see section on templates).

To create a blank page in a section that has a designated template click the arrow on the new
page button (see below) and select “Blank Template” from the list.

We will start this section by showing you how to insert new pages and add text to those pages.
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Creating a Page

You can add new pages to any section in your notebook. A page can be created using the New
task pane or by clicking New Page above the page tabs. For this concept we are going to use the
New task pane.

To open the New task pane, click Explain Choices on This Menu from either the
New sub-menu in the File menu or the New button on the standard toolbar:

Page CEFlR

Subpage Ckrl+Shif -+
Section

Section Group

ER el

mokebook, ..
Page fram Template, .,

& Explain Choices on this Menu, .. %
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This pane will list different types of content for you to create. Click on “New page” to
create a page in the current section:

New e
(c16
New
| Mew page
Create a new page at the end

of the current section, based
on the default template,

j Subpage
Create a new page that

immediately Follows the current
page and is grouped wikh ik,

[ Section

Create a new section in the
current notebook,

= Section Group

Create a new section graup in
thie current motebook, Section
Groups are useful for keeping
related sections togekher,

@ Motebook

Create a notebook to contain
all the information related to a
projeck, class, cusktamer, or
other topic. Pick from
kemnplates For work, school,
and personal use,

Templates

Mews page From template.. .
Dﬂ Templates on Office Cnline

The page inserted will always either use the default template for that section (e.g. a Meeting
Minutes template) or use a blank template. If it is a blank template it will be labeled Untitled
until you enter the title of the page in the title placeholder. (Your cursor will be placed here
when you click New Page.) The title of the current page will be shown in the title bar:
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Creating Advanced Notes

OneNote 2007 has a multitude of ways for you to collect and organize data. You can send web
pages to OneNote, gather screenshots from web sites, insert audio files, and add pictures.

This functionality will be most useful to you after the meeting when you are flowing in
documents tabled during the meeting (including images and other media that might have been
used by meeting participants). Often there will not be enough time to include these things in
your notes during the meeting but if you make a note to yourself, you can do so when
preparing the formal Meeting Minutes.

Adding an Audio/Video Recording

With OneNote you can add audio files to your page as part of your notes. To record an audio
file you need a microphone or other recording device. As a Minute-Taker you might want to
record the entire meeting or just important parts of it like motions or resolutions that would be
best noted down literally.

Although audio recordings are an excellent tool, you should be aware of several potential
pitfalls before using audio recording:

Get the permission of the group prior to doing any audio recording and notify everyone clearly
when audio recording begins and ends. If audio recording continues for long periods of time
people often forget they are being recorded and speak in ways which make it easy for their
words to be taken out of context or say things that they believed were spoken in confidence.

Always provide a visual reminder that recording is in progress (for example a large, red paper
that says “ON AIR” could be placed in the middle of the table whenever recording is taking
place and removed when the recording is paused or completed).

Your laptop microphone may not be sufficient for audio recording for a meeting room
environment so you will likely need an external microphone to effectively record meetings. Test
this equipment thoroughly before using it in a meeting and ensure you are completely familiar
with its operation. Technical issues with recording equipment should not hinder the flow of the
meeting.

(Like screen clippings, you can insert audio recordings from the Insert menu, Standard toolbar,
or the notification areaicon.)

Once you click Insert > Audio Recording, OneNote will start recording. You will
also see a toolbar of audio and video recording commands:
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Audio and Yideo Recording
b @ U A 'F"] oo:oapnios || il Ses Plaiari | 02

When you stop recording OneNote will create the audio file for you and place it on the page
automatically. It also records the date and time, and the cursor is inserted below the file to let
you type additional information:

Take

meeting n..
Sudio recording starked: 6:53 PM September-28-09

While you are recording audio or reviewing a recorded audio or video recording, whenever you
take notes they will be flagged with the time they were taken relative to the recording. This is
indicated by a small “play button” next to the note and shown when you hover your cursor over
the note. If you click this play button the recording will begin a few seconds before the note
was taken and continue playing.

This functionality makes it very easy to record sections of the meeting and take detailed notes
on them after the meeting has ended. This technique is especially recommended for the
following circumstances:
You are a meeting participant and the designated Minute-Taker. You might want to
record the meeting and take detailed minutes notes later by reviewing the recording so
that you can participate more fully in the meeting.
The meeting deals with technical areas you are unfamiliar with. By recording technical
terms you can review them later to make sure you have correctly noted them down
(this is especially important for motions, resolutions, and action items using these
terms).
A complex point was made and you want to ensure you correctly recorded it. Due to
the nature of a discussion, some points may be made which are difficult for a lay person
to follow (aside from the terminology used). If you can ask the speaker to enter then
point (or motion, or action item) into the meeting record directly by recording them
saying it you can transcribe it literally later. This will slow the meeting down less than
asking them to make the point to you so you can take it down literally during the
meeting.

The video recording command is also found in the Insert menu or Standard toolbar. From here,
it’s the same process as recording audio: the toolbar will appear, you can record your video,
and OneNote automatically embeds it into the note. It also notes the time and date that the
video was made.
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Like audio recording, you will almost certainly require special video recording equipment (e.g.
external camera connected to your PC, and audio equipment) and should follow the exact same
procedures as for audio recording. Video recording has an even greater chance of providing
unintended footage so please be especially careful you notify everyone they are on cameral
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Adding Pictures

Adding pictures to OneNote can be done from a file, a scanner, or a camera. Click Insert 2>
Pictures and then select the input source:

Insert

Tag
Cakloaok Task
Pictures
Files. .. %
Files as Prinkouts, .,
&+ Screen Clipping...
éi' Audio Recarding
‘2 Mideo Recaording
Symbal, .,
Date and Time  Alk+Shift+F
Cklook Meeting Dekails. .,
Hyperlink: ., ChrH-k

4 0 g el

Extra Writing Space

|l From Files...

a From Scanmer ar Camera. ..

When adding pictures from file folders, the browse dialog box will open for you to locate and
insert your picture. When inserting pictures from a scanner or a camera, OneNote will ask you
to select the device listed, and then will guide you through copying pictures from that device.

Adding Files

With OneNote you can embed virtually any file. From the Insert menu, click Files. The File dialog
box will open for you to add a file or a set of files to insert into a note/page. If any documents
were tabled before or during the meeting or are needed to understand the meeting minutes,
these could be added directly to the meeting minutes.
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Click Insert = Files, select the file or file set to embed, and then click Insert.

Simply double-click the file to open and view it:

Take ree Ling noles in OneNole

Examples of what to put in this section
Keep Microsaoft Office OrelNote 2007 running while you are in mestings ardjot down neetng
minctes, new ideas, key decisions, end brainstorming iceas.

Organizing Data During the Meeting

During the meeting you can use OneNote’s various list making and outlining features to easily
organize information as you are noting it down. This is especially valuable in indicating each
separate decision as it is made, etc. OneNote can organize information bullets and numbers,
creating lists, using outlining levels, and customizing tagged notes.

Using Bullets and Numbers

Bullets and numbering can come in handy when organizing notes and lists. You can select text
and click one of these commands to apply bullets or numbering, or you can turn the feature on
and then type. When taking notes during a meeting you will want to use bullets and numbers to
keep track of individual points as they are made, separating action items, etc.

You can start a bulleted list or numbered list using the Formatting toolbar or using keyboard
shortcuts:
To create a bulleted list type an “*” and hit tab. As you press Enter, a new
bullet item will be added to the list
To create a numbered list type “1.” and hit tab. Like the bulleted list, every
time you press Enter, a new numbered item will be added to the list.
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If you click the Bullets or Numbering button on the Formatting toolbar, the default bullets or
numbers will be applied to your text.
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You can click the drop-down arrow next to the bullet button or the number button to choose a
different bullet style:

¢ Calibri =11 = | B I U

®*  FEullet Style 2

S+ Bullet Style 3
®  Bullet Style 4
¥  Bullet Style 5

Mare. ..
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If you click the Bullets command or the Numbering command from the Format menu (or click
the More command from the toolbar menu), you will see the appropriate task pane.

Bullets Numbers
‘ Bullets v x iHumhering Y X
Qs Qs
Apply a bullet Apply numbering format
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Creating Lists

To start a bullet or numbered list, click on the bullet or number style, type the
comment or note, and then press Enter. This will automatically enter a new bullet
for you to continue the list:

Ist. “I'qeidizss Castle " he Glass Crsrs
Znd., TheKits Tunier o  TheXite amcer

3rd. The Shame of the Mation The Sham= of the Mat.on
Srh. ."\1‘15P1F|I‘: Mshes o -’\1"5.‘—.13'3 Sualk=s

Bullet and numbered lists can also be customized. By clicking the bullet or number you can
increase the size, apply color, or use the List command under the Format menu to apply
horizontal and vertical spacing:
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[Minute Taking Course I

Using Levels

Levels are used to organize bulleted and numbered lists after they have been created. With
Levels you can hide, or show the different levels in a list. To access a bullet or number level
menu, right click at the border of the text in the list, and choose to hide or select levels.

You can indent (or change the level) of a bullet or numbered list item using the
keyboard by pressing Alt+Shift and Left to “outdent” and Right to indent further.
You can move a list item up or down in a list by pressing Alt+Shift and up or
down.
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Customizing Tags

OneNote lets you apply default tags or custom tags to lists in order to remind you of events,
phone calls, to do items, and more. In some cases there may be an object you want to tag, but
do not have a tag for. To create your own tag, click the Tag button on the Standard
toolbar and click Customize My Tags. When recording meeting minutes you might want
to use these tags to designate motions, resolutions, action items, or tasks you (as a Minute-
Taker) need to perform once the meeting is over and you are formalizing the meeting minutes.

%ﬁ Showe Al Tagged Motes
% Cuskomize My ngs' 2

|51 ToDo Chrl+1
<¢  Imporkant Chrl42
?  Guestion Chrl+3

A, Remember For later  Ctel+4
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You will then see the Customize My Tags task pane.

 Customize My Tags T x
(610

Currenk tags:

| ToDoCtrl+1) -
Important (Cr+2)

Question {Cr+3)

Rermember for later (Cri+4)
Definition (Cr+5)

Highlight (Ctrl+&)

Contact (Cr [+

Address (T

Phone number (Cir+9)

Web site to visit

Idea

Fassword

Critical .

Project &

Project B

Movie 1o see
Book to read
Music o listen to
Saource for arficle

=
- 1 P (]

IPLEH L B <Bo @@ PN ® 0

Let’s take a look at what you can do with the various tags.

If you want to... Then...
Modify an existing tag Click the Modify button
Change a tag’s position in the menu Select the tag and use the up and down

arrows at the bottom of the pane
Remove a tag Select the tag and click Remove

Add a tag Click the Add button
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Using Templates for Meeting Minutes

Templates allow you to create custom layouts for your Meeting Minutes notes. In the example
notebook provided we have created OneNote templates of the included Meeting Minutes
styles (action, informal, formal) for you. The section below will help you understand how to
create your own templates or change the ones that have been provided in the example
notebook to best suit your minute-taking needs.

Opening a Template

The Template task pane is opened from the Format menu.

Formak |

A Fork... Chrl+D
I

=

Bullets. .

mumbering. ..

List. ..

Rule Lines 3
w  Show Page Title

Templates. .,

Section Color 3

Motebook Color, .

Once you have found the template you would like to use, click the template link, and OneNote
will add the new page to your notebook.

Please note that if a template has been designated as the default template for a section, this
template is used automatically when you add a new page. That has been done in the provided
example notebook in the meeting Minutes sections.

Using a Template

When you create a note using a template, the structure of the note is already in place; all you
have to do is enter the text.

You can edit notes created from templates the same way you would other notes.

Setting the Default Template
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If you find a template that you want to use for an entire notebook or section, you can set the
template as the default template. That way, you can click New Page, and the template will be
inserted instead of a blank page.

To set the default template, use the menu at the bottom of the Templates task pane. You will
see templates that are provided by OneNote and templates that were added to the notebook
(e.g. the provided meeting minutes templates or your own custom templates):

Chaose default template

Set the default template For new pages in the current section.

to Default Template 1:-}5
v
Simple Lecture Motes - Academic

Detailed Lecture Motes - Acadernic

Leckure Mokes and Study Questions - Academic
Math/Science Class Motes - Academic

Hiskory Class Motes - Acadenic

Defaulk - Blank

Stakemnent - Blank

Letter - Blank

Tabloid - Blank.

Legal - Blank

A3 - Blank »

Saving the Current Page as a Template

In the Templates task pane is a command that will allow you to save any page you create as
templates:

Create new template

Save current pagde as a templah‘ﬁ.']

Once you click the command, enter the template name, and set the template as a default
template if you wish:

Save fs Template

Template name: IBudget Meeting MNotes |

[ ] set as default kemplate for new pages inthe current section

Save ,\L[ Cancel J
s
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A Tour of the Minute-Taker’s Example Notebook

Today’s Meetings

For each day that you have a meeting scheduled in the future (e.g. the coming week) create a
page and title it with the date of the planned meeting. You can add new pages to this section as
you schedule new meetings and can archive the pages whose dates have passed (archive the
meeting notes into the Meeting Notes Archive section).

For each meeting on that day, place links to the OneNote pages where you have the minutes
page, the agenda, and any documents you may provide printouts of if you are a facilitator. This
helps you quickly see what meetings you have coming up and to add notes to these meetings to
stay on top of things (especially valuable if you are a facilitator).

You'll store the actual notes taken DURING the meeting (those that become Meeting Minutes)
in the Meeting Minutes template you choose to use (a new one is created for each meeting in
the Meeting Minutes section you use in this OneNote notebook). This section (Today’s
Meetings) is just to help you stay organized.

Agendas

Each meeting you attend should have an agenda. As a Minute-Taker you may not have the
responsibility to provide the agenda, but you may if you have another role you fulfill like the
meeting chair or facilitator. Regardless of where the Agenda comes from, when you have a
copy of it, place it in this section and link to it from your Today’s Meetings page and also on the
Meeting Minutes page for this meeting.

You can file these away in the Meeting Notes Archive once you have used them in the meeting.
Before you do that you should check to see if the agenda is to be formally included in the
Meeting Minutes.

Form and Checklists

As discussed in this course, you may be responsible to obtain signed agreements (position
contracts) and to use other documents (e.g. standard forms for recording motions and voting)
on a regular basis. If this is the case you should store these in this section, one per page.

As you generate standard forms you use for each meeting (e.g. formal templates for recording
votes, signed agreements, position agreements, etc) store them here so you can easily find one,
customize it, and print or e-mail it for use. When you require a paper or form, simply copy the
page it is on and work on the copy filling in what detail you require before printing it for
distribution during the meeting.

Meeting Minutes

Choose a style of minute-taking that is right for your organization or develop your own.
Templates included are: Action, Informal, and Formal. Once you have chosen a style works for
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your organization or have created your own you can delete the unused Meeting Minutes
sections.

When you add a new page to this section, it will use the Default Template for the section (you
can create your own template or use the templates provided). Create a new page for each
meeting you record minutes for.

Take your notes for the meeting below the actual Meeting Minutes template area of the page.
Once you have recorded the minutes as notes during the meeting, return to the top of the
template and fill in the sections, summarizing your notes.

Send out the meeting minutes to the meeting participants (e.g. using e-mail) and place a copy
(either printed or electronic) in the Meeting Minutes book.

Once all revisions of the Meeting Minutes are complete you can move the minutes to the
Meeting Notes Archive section, if you want to (this helps keep your day to day minute-taking
section organized and clean).

Distributing Meeting Minutes...

Once you have compiled your meeting minutes into the meeting minutes format you have
decided to use and are ready to distribute them to the meeting attendees, you have a number
of ways you can distribute the notes:

...As an e-mail

You can copy the OneNote meeting notes into a Microsoft Outlook e-mail message (you can
also use other e-mail programs, especially those that let you compose HTML e-mail). You would
do this by selecting the text of your completed meeting minutes in OneNote, copy them (either
using the Edit menu’s copy function or pressing Ctrl + C), and pasting the minutes into an e-mail
message.

When pasting the notes into Outlook be sure to watch for the clipboard icon ( = ) and use it to
select “Keep source formatting” to make sure your notes look as close as possible to the
original after you paste them.

...As a Word document

Microsoft Word documents can be distributed to the meeting attendees by sharing them using
a web-based portal like Microsoft SharePoint, saving them in a shared document repository
(e.g. a shared folder in Windows), or by e-mail the document as an e-mail attachment. You can
save the notes to a Word document by creating a new Word document and copying the
meeting minutes as you would for the Outlook message, above.

...As a shared OneNote notebook
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Another option to share your meeting minutes is to store the OneNote notebook in a directory
that the meeting attendees have access to. In this way they could read the meeting minutes
directly from your notebook. Only the Minute-Taker should actually edit the notebook, though.

Once you have sent out the meeting minutes some attendees might have changes they would
like to make to the minutes. These changes should be gathered up, made, and a new version of
the minutes sent out until everyone agrees on the Minutes. At that point the Minutes should be
archived in a permanent meeting minutes binder (or similar electronic document). If you need
to store a printed copy, you can print directly from OneNote as you would from any other
Microsoft Office 2007 program.

Meeting Notes Archives

Once you have formally completed the process of recording meeting minutes, distributing
them, and finishing any changes made to them (usually at this point then minutes are recorded
in an official Meeting Minutes binder or electronic file), you can copy the pages to the Meeting
Minutes Archive section from the other OneNote sections to keep those sections clean and
organized.

Archiving pages is a good idea (as opposed to deleting them) for two reasons:

- Itis very easy to search in OneNote and so you can quickly refer back to past agendas
and meeting minutes even during a fast paced meeting if there is a question about
something that happened before.

Even if you have printed the meeting minutes or stored them in another electronic
document format, it never hurts to have an additional copy backed up in the Meeting
Minutes Archive section of your notebook.
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Further Reading:

v

Effective Minute-Taking: Tips to Improve Your Meeting-Recording Skills by Joan Burge
http://www.wildapricot.com/articles/how-to-write-effective-meeting-minutes

Mina’s Guide to Minute Taking, Eli Mina Consulting Vancouver, BC, Canada

Minutes for meetings ,Second edition published in 2019 Printed on recycled paper by
Footprint Workers Co-operative

Taking Minutes of Meetings, Joanna Gutmann | Revised Second Edition
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